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ВСТУП 
Опис дисципліни. Предметом вивчення навчальної дисципліни є існуючі 

методи і технології аерокосмічних досліджень ґрунтового покриву, який є 
одним з основних природних ресурсів, а також поєднання традиційних методів 
досліджень разом з новими методами: геоінформаційними технологіями, 
методами дистанційного зондування, геоморфологічним аналізом рельєфу, як 
провідного фактора ґрунтоутворення. 

Найменування показників  Характеристика навчальної дисципліни 
денна форма навчання заочна форма навчання 

Кількість кредитів 
3 кредити ЄКТС. 

Статус дисципліни: 
обов’язкова 

Змістових модулів 
(розділів) – 2 

Рік підготовки: 
1-й 1-й 

Семестр 

Загальна кількість  
годин 90. 

2-й 2-й 
Лекції 

16 год. 4 год 
Практичні, (семінарські) 

- год. - год. 
Лабораторні 

18 год. 6 год. 
Самостійна робота 

56 год. 80 год. 
Тижневих годин для 
денної форми навчання: 
аудиторних – 4; 
самостійної роботи 
здобувача – 4. 

Вид контролю: 

екзамен. екзамен 

 
Метою викладання навчальної дисципліни «ГІС у ґрунтознавстві» є 

надання студентам необхідного обсягу знань з основ сучасних методологій і 
технологій збору, обробітку та аналізу геоінформації для оптимізації процедури 
прийняття оптимальних рішень щодо вирішення ґрунтознавчих і агрохімічних 
завдань. 

Основними завданнями вивчення дисципліни «ГІС у ґрунтознавстві» є 
формування у фахівця теоретичних знань і практичних навичок використання 
геоінформаційних систем у виробництві для одержання інформації необхідної 
для прийняття рішень щодо стану агроландшафтів, з метою ландшафтно-
екологічного зонування території, створення карт стану ґрунтів, прогнозування 
продуктивності сільськогосподарських культур тощо. 

У результаті вивчення навчальної дисципліни студент повинен знати: 
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основи сучасних технологій аналізу та обробітку інформації; базові поняття 
щодо геоінформаційних технологій та статистичного аналізу; дистанційного 
зондування та статистичного аналізу; алгоритм використання новітніх 
технологій при проведенні ґрунтового обстеження території; уміти: працювати 
з геоінформаційними системами; редагувати атрибутивні і просторові дані; 
будувати робочий набір з певної кількості інформаційних шарів; користуватись 
науковою і довідниковою літературою; аналізувати та оцінювати стан 
ґрунтових ресурсів. 

Базовими дисциплінами для успішного засвоєння програмного матеріалу 
дисципліни є інформаційні технології в агрономії та бонітування ґрунтів і 
якісна оцінка земель. 

Дана навчальна дисципліна забезпечує формування таких програмних 
результатів навчання:  

ІК.01. Здатність розв’язувати складні задачі i проблеми у сфері агрономії 
під час здійснення професійної діяльності або у процесі навчання, що 
передбачає проведення досліджень та/або здійснення інновацій та 
характеризується комплексністю та невизначеністю умов. 

СК.02. Здатність аналізувати та оцінювати сучасні проблеми, 
перспективи розвитку та науково-технічну політику в сфері агрономії. 

СК.04. Здатність оцінювати придатність земель для вирощування 
сільськогосподарських культур з урахуванням вимог щодо забезпечення 
кількості та якості продукції. 

СК.10. Здатність розробляти заходи щодо відновлення родючості ґрунтів, 
проводити оцінку якості ґрунтів, складати експертний висновок щодо якості 
ґрунтів конкретної території. 

СК.12. Здатність проводити моніторинг ґрунтів, оцінку якості земель 
різними методами для різного цільового призначення, користуватись засобами 
ГІС і ДЗЗ при проведенні земельно-оціночних робіт 

СК.13. Здатність застосовувати ГІС при дослідженні ґрунтів, 
користуватися нормативною базою при оцінці якості земельЛабораторні роботи 
з дисципліни «ГІС в ґрунтознавстві» виконуються студентами із використанням 
сучасного комп’ютерного обладнання за допомогою ГІС-програм, що дозволені 
до вільного використання з навчальною метою. Успішне виконання та захист 
лабораторних робіт є обов’язковою умовою складання заліку з дисципліни «ГІС 
в ґрунтознавстві». 
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Програма дисципліни 
 

Розділ 1 Основи геоінформаційних систем 
Тема 1 Організація та функціонування геоінформаційних систем. 
Ознаки ГІС. Переваги картографічного матеріалу, що утворені в ГІС. 

Функції ГІС: інформаційно-довідкові функції, консультаційно-експертні 
функції, функції автоматизованого картографування, функції просторового 
аналізу і моделювання, функції моделювання і прогнозування процесів, функції 
підтримки прийняття рішень, контрольні функції. Класифікація ГІС. 
Функціональна схема ГІС: підсистема уведення, підготовки і попередньої 
обробки інформації, підсистема збереження, оновлення і управління баз даних, 
Підсистема обробки інформації, моделювання та аналізу даних, Підсистема 
контролю, візуалізації і виведення інформації. Зв’язок ГІС з іншими 
дисциплінами. Геоінформаційні технології. Області застосування ГІС. Складові 
компоненти ГІС. Відмінність ГІС від інших інформаційних систем: системи 
автоматизованого проектування (САПР), автоматизовані картографічні системи 
(АКС), Системи управління мережами (АМ/FМ: Automated Mapping/Facilities 
Management), Системи управління базами даних (СУБД). 

Тема 2 Просторові моделі даних, їх організація 
Відображення об’єктів реального світу в ГІС. Класифікація даних 

використовуваних в ГІС. Компоненти геоінформаційного простору (дискретні 
явища: точкові, лінійні об’єкти, полігони, поверхні, атрибутивні дані). 
Принципи побудови растрових моделей. Піксель. Характеристики растрових 
моделей. Вибірка значень комірки і топологія растрової моделі (топологічна 
структура растра). Растрові шари. Використання растрів для зображення 
безперервних поверхонь. Формати растрової графіки. Методи стиснення 
растрових даних: метод групового кодування, метод Boustrophedon, метод 
ланцюжкового кодування, метод Мортона. Способи формалізації просторових 
даних в растрових моделях: регулярні мережі, нерегулярні мережі, ієрархічні 
моделі, безструктурні гіперграфові моделі, решітчасті моделі. Перспективи 
застосування растрових моделей. Векторна структура, векторне подання 
просторових даних. Вибір способу формалізації і перетворення структур даних. 
Векторна та растрова модель представлення даних, їх характеристики, переваги 
і недоліки. 

Тема 3 Властивості об’єктів у ГІС  
Векторні моделі даних в ГІС. Векторна структура, векторне подання 

просторових даних. Вибір способу формалізації і перетворення структур даних. 
Векторна та растрова модель представлення даних, їх характеристики, переваги 
і недоліки. Перетворення «вектор–растр» и «растр–вектор». 

Тема 4 Прикладні можливості ГІС 
Загальні положення. Об’єктно-орієнтована, пошарова (пластова) 

організація і збереження просторових даних. Вимоги до створення й управління 
базами геопросторових (ґрунтово-агрохімічних) даних. Методи і технології 
візуалізації інформації в ГІС. Моделювання даних. Представлення даних. 
Модель даних (цілісність даних, предметна область). Концептуальна, або 
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інфологічна модель. Основні конструктивні елементи інфологічної моделі. 
Даталогічна модель. Фізична модель. Модель «сутність–зв'язок». Основні 
конструктивні елементи. Класифікація БД. Ієрархічна модель даних. Мережева 
модель даних. Реляційна модель даних. Об'єктно-орієнтована модель даних. 
Моделі даних, їх переваги і недоліки. Функціонування баз даних, їх 
функціональні можливості: опис структури даних, маніпулювання даними, 
завантаження бази і формування звітів, мова запитів, діалогові засоби. Ведення 
баз даних. Засоби адміністратора баз даних. Відновлення баз даних. Керування 
даними в ГІС. 

Рекомендована література 
1. Ямелинець Т.С. Застосування географічних інформаційних систем у 

ґрунтознавстві: Навчальний посібник. – Львів: Видавничий центр ЛНУ імені 
Івана Франка, 2008. – 196 с.  

3. Морозов В.В. Геоінформаційні системи в агросфері: Навч. посібник / 
В. В. Морозов, К. С. Лисогоров, Н. М. Шапоринська. – Херсон: Вид-во ХДУ, 
2007. – 223 с. 

4. Пітак І. В. Геоінформаційні технології в екології: Навч. посібник / І. В. 
Пітак, А. А. Негадайлов, Ю. Г. Масікевич, Л. Д. Пляцук [та ін.].– Чернівці:, 
2012.– 273с. 

5. Мокін В. Б. Геоінформаційні системи в екології: Електронний 
навчальний посібник / В. Б. Мокін, Є. М. Крижановський; Під ред. Є. М. 
Крижановського. – Вінниця : ВНТУ, 2014. – 192 с. 

6. ГІС в екологічних дослідженнях та природоохоронній справі: навч. 
посібник / Ю. М. Андрейчук, Т. С. Ямелинець. – Львів : Простір-М, 2015. – 
284 с. 

7. Застосування географічних інформаційних систем у ґрунтознавстві: 
Навчальний посібник. – Львів: Видавничий центр ЛНУ імені Івана Франка, 
2008. – 196 с. 

8. Черлiнка В. Р. Геоiнформацiйнi системи в картографуваннi ґрунтового 
покриву / В.Р.Черлiнка, Ю.М.Дмитрук. – Навч. посiбник. – Частина 1. – 
Чернiвцi: ЧНУ, 2018. – 100 с. 

9. Дмитрук Ю.М. Цифрові моделі рельєфу в ґрунтознавстві / 
Ю.М.Дмитрук, В.Р. Черлінка. – Навчальний посібник. – Чернівці: ЧНУ, 2015. – 
140 с. 

 
Розділ 2 Геоінформаційні системи та експертна оцінка ґрунтів 

Тема 5 Геоінформаційний (просторовий) аналіз 
Методи класифікації в ГІС. Терміни і визначення. Буферний аналіз: типи 

буферів, вибір об’єктів на відстані, аналіз географічного збігу і включення, 
аналіз близькості, зонування території за допомогою полігонів Тиссена-
Вороного Просторова. Інтерполяція даних. Метод крігінгу. Земельний кадастр 
та його аналіз з застосуванням геостатистичних методів. Класифікація 
просторових об’єктів, явищ. Методи класифікації в ГІС. Класифікація в ГІС при 
використанні карт. Практичне застосування принципів класифікації. Аналіз 
геоінформації за допомогою картографічної алгебри. Основні функції ГІС, що 
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пов'язані з аналізом просторово-атрибутивній інформації. Можливості 
просторового аналізу. Перекласифікація. Багатоваріантний аналіз і 
класифікації. Статистичні карти. Районування в ГІС. Нормалізація. 
Анаморфози. Площинні, об’ємні анаморфози. Генералізація. Агрегування 
даних. Класифікація в ГІС при використанні карт. Використання стандартних 
схем класифікації. Природна розбивка. Квантіль. Рівні інтервали. Практичне 
застосування принципів класифікації. Розчинення меж (Перекласифікація, 
Рекласифікіція). 

Тема 6 Геоінформаційний аналіз даних дистанційного зондування 
ґрунтового покриву 

Попереднє опрацювання та візуалізація матеріалів ДЗЗ. Ручне 
дешифрування. Напівавтоматичне дешифрування: розрахунок спектральних 
індексів та порогова класифікація. Автоматична класифікація (некерована). 
Аналіз та оцінка даних із супутникових знімків. 

Тема 7 Програмні засоби для створення, аналізу та функціонування 
ГІС 

Програмне забезпечення для роботи із супутниковими знімками 
(ArcGIS, QGIS, Google Earth). Функціонал, можливості, алгоритми роботи. 
Ресурси для отримання інформації ДЗЗ. 

Тема 8 Методи моделювання поверхонь у ГІС 
Цифрові моделі поверхонь. Растрові моделі поверхні. Векторні моделі 

поверхні. Методи аналізу статистичних поверхонь. Просторові запити. Об'єми, 
що обмежуються поверхнями. Класифікація поверхонь. Ухил. Експозиція 
схилів (аспект). Профіль поверхні. Взаємна видимість. Аналіз видимості по 
променях від заданої точки (ArcView, 3D-Analyst). Визначення полігонів 
взаємної видимості. Поняття про інтерполяцію і екстраполяцію. Основна задача 
та застосування інтерполяції. Лінійна інтерполяція. Метод зворотних зважених 
відстаней. Тренд. Поверхні тренда першого, другого і третього порядку. Аналіз 
трендів для оцінки ймовірності ґрунтових змін. Крігінг. Елементи крігінга. 
Сплайн. Використання сплайн-функцій. Метод сплайн-аппроксимації. 
Порівняння методів. 

 
Рекомендована література  
1. Ямелинець Т.С. Застосування географічних інформаційних систем у 

ґрунтознавстві: Навчальний посібник. – Львів: Видавничий центр ЛНУ імені 
Івана Франка, 2008. – 196 с.  

3. Морозов В.В. Геоінформаційні системи в агросфері: Навч. посібник / 
В. В. Морозов, К. С. Лисогоров, Н. М. Шапоринська. – Херсон: Вид-во ХДУ, 
2007. – 223 с. 

4. Пітак І. В. Геоінформаційні технології в екології: Навч. посібник / І. В. 
Пітак, А. А. Негадайлов, Ю. Г. Масікевич, Л. Д. Пляцук [та ін.].– Чернівці:, 
2012.– 273с. 

5. Мокін В. Б. Геоінформаційні системи в екології: Електронний 
навчальний посібник / В. Б. Мокін, Є. М. Крижановський; Під ред. Є. М. 
Крижановського. – Вінниця : ВНТУ, 2014. – 192 с. 
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6. ГІС в екологічних дослідженнях та природоохоронній справі: навч. 
посібник / Ю. М. Андрейчук, Т. С. Ямелинець. – Львів : Простір-М, 2015. – 
284 с. 

7. Застосування географічних інформаційних систем у ґрунтознавстві: 
Навчальний посібник. – Львів: Видавничий центр ЛНУ імені Івана Франка, 
2008. – 196 с. 

8. Черлiнка В. Р. Геоiнформацiйнi системи в картографуваннi ґрунтового 
покриву / В.Р.Черлiнка, Ю.М.Дмитрук. – Навч. посiбник. – Частина 1. – 
Чернiвцi: ЧНУ, 2018. – 100 с. 

9. Дмитрук Ю.М. Цифрові моделі рельєфу в ґрунтознавстві / 
Ю.М.Дмитрук, В.Р. Черлінка. – Навчальний посібник. – Чернівці: ЧНУ, 2015. – 
140 с. 

 
Методи контролю  

Під час вибору критеріїв оцінки засвоєння здобувачем програми 
дисципліни враховано виконання програми і засвоєння матеріалу в частині 
лекційних і лабораторних та практичних занять, а також виконання 
передбаченої програмою самостійної роботи.  

Усі види контролю (усне опитування, письмове опитування, тестове 
опитування) тісно пов’язані та організовуються так, щоб стимулювати 
ефективну самостійну роботу здобувачів і забезпечити об’єктивне оцінювання 
рівня їх знань. 

Після закінчення вивчення курсу підсумковий контроль з дисципліни 
проводиться у формі екзамену і здобувач може набрати протягом семестру в 
точках контролю до 60 балів включно. 

Контроль знань, умінь і навичок студентів – невід’ємна складова 
педагогічного процесу та форма зворотного зв’язку при вивченні курсу «ГІС у 
ґрунтознавстві» використовуються такі види контролю: 1) поточний; 
2) періодичний (проміжний); підсумковий.   

Поточний контроль – контроль рівня знань та вмінь у процесі навчання, 
який про-водиться на лекціях, лабораторно-практичних заняттях. Його види та 
форми: 

Експрес опитування – опитування на засвоєння попередньої лекції (на 
початку чергової лекції); опитування під час лекції на розуміння її суті; 
контроль за засвоєнням матеріалу лекції;  співбесіда; програмований контроль 
знань (картки, вирішення проблемних і ситуаційних завдань, тестування); 
модульний контроль. 

Поточний (проміжний) контроль – це контроль після вивчення розділу, 
теми змістових модулів. Він включає такі види контролю: контрольні роботи; 
колоквіуми; тестові опитування; контроль за формуванням практичних умінь і 
навичок; контроль за умінням вирішувати професійно-орієнтовані завдання. 

Підсумковий контроль – це контроль, який здійснюється в кінці 
вивчення курсу. Це семестровий контроль: комплексні тестові контрольні 
завдання, семестровий іспит. 
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ЗАГАЛЬНІ ВІДОМОСТІ ПРО ГІС 
 

ГІС – це система апаратно-програмних засобів та алгоритмічних 
процедур, яка створена для цифрової підтримки, поповнення, маніпулювання, 
аналізу, математико-картографічного моделювання та образного відображення 
просторово-координованих даних. ГІС є похідною баз даних, а вірніше, 
системи керування базами даних (СКБД), але з розширеною концепцією яка 
дозволяє працювати з просторово-розподіленою інформацією та вирішувати 
завдання, що пов’язані з просторовим аналізом. 

База даних (БД) – це об’єктивна форма подання й організації сукупності 
даних, систематизованих таким чином, щоб ці дані могли бути знайдені й 
оброблені за допомогою ЕОМ. Найпростіша БД – таблиця, в якій наведені 
характеристики будь-якого об’єкта, наприклад журнал виконання аналізів у 
хімічній лабораторії, або прайс у магазині. 

Обов’язкові ознаки ГІС: 
 географічна (просторова) прив’язка даних; 
 автоматизованість системи; 
 картографічний інтерфейс; 
 можливість оперативного оновлення баз даних за рахунок нової інформації; 
 можливість генерування нової інформації на основі синтезу наявних даних; 
 відображення просторово-часових зв’язків об’єктів; 
 забезпечення прийняття рішень. 

Переваги карт, що утворені в ГІС: 
 можливість зручної роботи з широким спектром даних з одночасним 

розміщенням їх на карті;  
 можливість проведення аналізу даних і моделювання різних сценаріїв 

прийняття рішень, що дозволяє запобігти помилок;  
 можливість представлення результатів у наочному (а значить у більш 

зрозумілому) вигляді; 
 карти ГІС інтерактивні, тобто є можливість зручного введення та зміни 

даних без необхідності кожного разу складати нову карту. 
 

Компоненти ГІС: 
Апаратний компонент: 

 матеріальний (фізичний) компонент, що забезпечує роботу програми на 
фізичному рівні; 

 комп’ютер є основою апаратного компонента ГІС; може бути від 
найпростіших ПК і КПК до наймогутніших суперкомп’ютерів; 

 уведення даних:  через сканер, дигітайзер, клавіатуру або з баз даних; 
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 виведення інформації: монітор (візуальне), принтер (папір), плотер. 
Програмний компонент: 

 програмне забезпечення ГІС забезпечує функції й засоби, необхідні для 
зберігання, аналізу й подання географічної інформації; 

 найбільше широко використовувані програми ГІС – MapInfo, ARC/Info, 
AutoCAD Map,  TNT,  та ін.  

 Інформаційний компонент: 
 дані, що вводяться та аналізуються у ГІС; 
 вибір даних залежить від завдання й ваших фінансових можливостей.  
 дані можуть бути використані з різних джерел - баз даних вашої організації, 

інтернету, комерційних баз даних і т.д.; 
 можуть бути цифровими, графічними, у вигляді знімків (растрових 

зображень). 
Користувальницький компонент: 

 люди, що працюють і користуються ГІС, умовно можуть бути розділені на 
такі групи: 

 оператори ГІС,  чия робота полягає в  занесенні даних у базу даних та 
розміщенні їх на карті; 

 аналітики ГІС, чия функція полягає в аналізі й подальшій роботі із цими 
даними; 

 експерти ГІС, які на підставі отриманих результатів повинні прийняти 
рішення; 

 безпосередні користувачі; широкі верстви населення (через готові програмні 
додатки або інтернет). 

Методологічний компонент: 
 існує багато способів створення карт у ГІС і методів подальшої роботи з 

ними; 
 методологія залежить від: 1. завдання; 2. від даних, що обробляються; 3. від 

фінансових можливостей (продаж ГІС окремими модулями). 
 

Завдання ГІС 
ГІС вирішують чотири типи завдань:  
1) Збір даних   

 забезпечується підсистемою збору даних, що збирає й проводить попередню 
обробку даних з різних джерел; 

 вихідна інформація береться з таких джерел, як аерофотозйомка, 
дистанційне зондування, геодезичні роботи, словесні описи й замальовки, 
дані статистики й т.д.; 
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 проводиться попередня обробка різних типів просторових даних (наприклад 
– оцифровування паперових карт, векторизація, і т. ін.). 

2) Обробка даних («запит») 
 забезпечується підсистемою зберігання й вибірки даних, що організує 

просторові дані з метою їхньої вибірки, відновлення, редагування; 
 дозволяє робити запити, що повертають тільки потрібну, контекстно-

пов’язану інформацію, вона переносить акцент із загальної інтерпретації 
інформації на формулювання адекватних запитів; 

 підсистема зберігає або явно, або неявно, геометричні координати точкових, 
лінійних і площинних геометричних об’єктів і пов’язані з ними 
характеристики (атрибути); 

 комп’ютерні методи пошуку природно властиві самому програмному 
забезпеченню ГІС. 

3) Моделювання, інтерпретація та аналіз даних: 
 забезпечується підсистемою маніпуляції даними й аналізу, що, виконавши 

різні завдання на основі цих даних, групує й розділяє їх; установлює 
параметри й обмеження й виконує моделюючі функції; 

 підсистема аналізу дозволяє значно спростити й полегшити аналіз 
просторово-координованих даних, практично виключити ручну працю й 
значною мірою спростити розрахунки, виконувані користувачем; 

 підсистема аналізу є «серцем» ГІС. 
4) Розробка проектів просторових рішень: 

 забезпечується підсистемою виведення, що відображає всю базу даних або 
частину її в табличній, діаграмній або картографічній формі; 

 підсистема висновку дозволяє компонувати результуючі дані в будь-якій 
зручній для користувача формі; 

 серед прикладів вихідних даних – друкування адрес на конвертах за 
результатами пошуку в базі даних потенційних клієнтів з метою поширення 
реклами; 

 побудова карт. 
Інформація в ГІС організовується у вигляді шарів, які можна назвати 

тематичними, тому що кожен шар складається з даних з певної тематики. 
Наприклад, якщо ви вивчаєте певну територію, то один шар карти може 
містити дані про дороги, другий – про водоймища, третій – про населення, що 
проживає там, четвертий про лікарні і так далі.  Кожен з шарів даних може: 
 окремо проглядатися у вигляді картографічного зображення; 
 поєднуватися відразу з декількома іншими, створюючи, залежно від 

комбінації шарів, певні тематичні карти. 
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ВИКОНАННЯ ЛАБОРАТОРНИХ РОБІТ 
Лабораторні роботи № 1-8 виконуються в програмі ГІС MapІnfo.  

 
Короткий опис ГІС MapІnfo 

MapInfo належить до класу векторних ГІС. Це означає, що основними 
об’єктами, з якими оперує система, є векторні об’єкти. Побудова карти в 
MapInfo  полягає в створенні сукупності векторних об’єктів, що відображають 
необхідні об’єкти місцевості й прив’язки векторних даних до таблиць, у яких 
зберігається атрибутивна інформація. 

Основні технологічні процеси в MapInfo можна розділити на чотири 
групи: введення даних, графічне редагування, геоінформаційне моделювання, 
підготовка даних до друку. У даній частині методичних вказівок будуть 
розглянуті введення, графічне редагування й вивід даних,  що потрібно для 
початкового освоєння системи. 

Побудова карти може бути реалізована трьома шляхами: 
 створення нової карти на основі інформації, яка вводиться оператором. 
 створення нової карти на основі існуючої векторної карти шляхом її 

модифікації або відновлення. 
 створення нової карти на основі трасування растрових зображень, які 

можуть являти собою скановані знімки або карти. 
Кнопки основних інструментальних панелей MapInfo 

Панель «Операції» Панель «Пенал» 

 

«Додати вибірку в групу» 
 

«Вибір області» 
 

 «Перенесення» 
 

«Показати по-іншому» 
«Долонька» 

 

 «Інформація» 
 

 «Підпис» 
 

 «Керування шарами» 
 

 «Легенда» 
 

 «Вибір у рамці» 
 

 «Вибір у колі» 
 

 «Лінійка» 
 

«Стрілка» 
 

 «Вибрати змінювану групу» 
 

«Стиль ліній» 
 

«Полігон» 
 

«Полілінія» 
 

«Прямокутник» 
 

«Стиль областей» 
 

«Форма (Фрейм)» 
 

«Округлений прямокутник» 
 

«Символ» 
 

«Стиль символу» 
 

«Текст» 
 

«Стиль тексту» 
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Створення нової карти на основі інформації, що вводиться оператором із 
клавіатури найменш продуктивно й на практиці не застосовується. 
Технологічно цей процес збігається з процесом редагування карт. У процесі 
роботи крім основного меню використовують три основні інструментальні 
панелі в MapInfo: «Операції», «Пенал», «Програми». 

 
Основні поняття ГІС MapІnfo 

У ГІС дані містять три основні характеристики: місце, час, тема. Але при 
організації моделей даних ГІС  використовують два класи: 

Позиційні дані (просторові), що визначають місце розташування. 
Атрибутивні дані, що визначають тематичні й часові характеристики. 
Просторові дані можуть бути описані за допомогою векторних моделей, 

які утворюються трьома типами даних: 
 точками (точковими об’єктами); 
 лініями (полілініями, лінійними об’єктами); 
 полігонами (ареалами, площинними об’єктами). 

Геоінформатика є новою наукою, тому її терміни ще недостатньо 
стандартизовані. Тому  в різних інструментальних системах ГІС можуть бути 
використані різні терміни для позначення однакових елементів моделей або 
самих моделей. Це визначає необхідність уточнення основних понять, які 
використовуються в роботі конкретної ГІС, у нашому випадку MapInfo .  

Географічні дані (Geographic data), синоніми: просторові дані – Spatial 
Data, геодані – Geodata). Набір даних, які індивідуально або в певній сукупності 
визначають географічне положення й форму реальних просторових об’єктів.  

Реальний просторовий об’єкт (Spatial Entity Object), синонім – 
географічний об’єкт (Geographic Entity) – будь-який конкретний або 
абстрактний об’єкт реального світу, що може бути визначений однозначним 
змістом і границями й описаний у ГІС у вигляді набору геоданих.  

Шар, Картографічний шар (Map Layer, Map Overlay)  – набір 
однотипних векторних графічних даних: точкових, лінійних, ареальних. 
Основний спосіб представлення даних таблиці у вікні Карти. Карта в MapInfo  
може складатися з декількох шарів.  

Крім векторних шарів з об’єктами таблиць MapInfo , у вікні Карти 
можуть бути показані растрові шари (шар з растровим зображенням), а також 
тематичні шари й Косметичний шар. Самим верхнім у вікні Карти завжди є 
Косметичний шар, дані якого перебувають у спеціальній тимчасовій таблиці. 

Таблиця (Table) – основна  інформаційна одиниця  MapInfo . На відміну 
від звичайного поняття таблиці,  в MapInfo  вона являє собою шар, прив’язаний 
до табличної бази даних і по суті відповідає карті. 
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Кожний рядок таблиці бази даних містить інформацію про окремий 
географічний об’єкт. Кожний стовбчик містить певний атрибут. 

Таке подання даних дозволяє застосовувати методи ділової графіки для 
візуалізації статистичної, економічної й іншої просторово-тимчасової 
інформації. Зокрема, це дає можливість  показати  на географічних об’єктах  
діаграми й графіки подібно тому, як це робиться в пакетах ділової графіки або в 
електронних таблицях. Кожній таблиці може відповідати один шар (карта). Для 
позначення зображення таблиці (табличних даних) у MapInfo  використовують 
термін «список». 

Робочий Набір (Workspace) – сукупність даних (таблиць і шарів), яка 
дозволяє  створювати складну карту (картографічну композицію). 

У робочому наборі запам’ятовуються як імена таблиць, вікна, допоміжні 
вікна, так і їх розташування на екрані. У такий спосіб користувач може зберегти 
робочий стан вікон MapInfo  і викликати його в наступних сеансах роботи.  

При завантаженні робочий набір відкриє всі таблиці й усі вікна, які були 
відкриті в момент збереження робочого набору, і всі вікна, розташувавши їх у 
тих місцях і в тому порядку, у якому вони перебували в момент збереження 
набору. 

Легенда (Legend) – список умовних позначень використовуваних  картою 
або графіком.  

Звіт (Layout) – сукупність графічних даних, призначена для виводу на 
друк. Звіт може містити кілька фреймів (вікон), у яких розміщається різна 
інформація: карти, легенди, графіки, додаткові підписи і т.д. 

Трасування (Tracing) – в MapInfo  метод векторизації зображень, при 
якому користувач створює векторні об’єкти шляхом постановки оцінок 
(трасування) на тлі растрової основи.  

Геокод  (Geocode) – кодове значення (сполучення символів), привласнене 
просторовому об’єкту, що відбиває інформацію про географічне положення 
об’єкта й використовується для доступу до даних ГІС, що стосується до цього 
об’єкта.  

Геокодування (Geocoding) – процедура позиціонування  інформації  бази 
даних (реляційної таблиці) відповідно до приєднаних об’єктів карти. Таблиця, 
що описує сукупність об’єктів даного шару, складається із записів, що мають у 
числі інших, географічні (позиційні) дані (наприклад, назва країни, області, 
міста або адреса). При геокодуванні MapInfo  вибирає  цю інформацію й 
асоціює її з існуючої позиційною  інформацією, яка дозволяє здійснити 
прив’язку й показ об’єкта на карті.  

Проекція карти – математична модель, що здійснює проектування 
кожної точки земної поверхні на карту. Залежно від вибору виду проекції 
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(способу передачі координат) візуальне подання однієї й тієї ж карти буде 
різним. Кожна проекція задається набором  параметрів. Відмінність між 
проекціями підкреслюється різними видами координатної сітки. 

Координатна сітка – сукупність горизонтальних (широта) і 
вертикальних (довгота) ліній, розташованих на світових картах через рівні 
проміжки (наприклад, через кожні десять градусів). Використовується для 
зручності визначення координат об’єктів. У MapInfo  сітка представлена у 
вигляді окремого шару. 

Центроїд – центр об’єкта карти. Для більшості об’єктів центроїдом є 
геометричний центр об’єкта, тобто точка розташована в середині об’єкта. Але в 
деяких об’єктах  геометричний центр перебуває поза об’єктом, а центроїд 
повинен перебувати в самому об’єкті.  

Центроїд використовується для завдання розташування підписів об’єктів, 
діаграм і стовпчастих графіків тематичного виділення. При геокодуванні 
координати центроїда використовуються для завдання розташування об’єкта на 
карті. 

Полігон (Polygon) – елементарний геометричний об’єкт географічної 
бази даних ГІС, що визначає місце розташування відповідного площинного  
реального просторового об’єкта. 

Полілінія (Polyline) – елементарний геометричний об’єкт географічної 
бази даних ГІС, що визначає місце розташування відповідного лінійного 
реального просторового об’єкта та складається з точок (вузлів) та відрізків 
ліній, що їх з’єднують. 

Цифрова карта (Digital Map) – цифрове вираження векторного або 
растрового подання загальногеографічної або тематичної карти, записане в 
певному форматі, що забезпечує її зберігання, редагування й відтворення. 

 
УВАГА! Перед початком роботи з ГІС створіть власну папку, в якій в 

подальшому зберігайте всі створені та змінені Вами в процесі виконання 
лабораторних робіт файли та робочі набори.  
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Лабораторна робота № 1. Знайомство з ГІС-MapInfo 
 
Мета роботи: знайомство з ГІС-MapInfo, практичне вивчення способів 

надання інформації в ГІС, придбання навичок групування необхідної 
інформації в робочий набір. 

 
УВАГА! Після виконання лабораторної роботи студент має знати назву 

та призначення кнопок робочої панелі «Операції», вміти відкривати та 
закривати файли, створювати та зберігати робочий набір залежно від 
завдання, що виконується. 

 
Хід роботи 
1) Відкрийте файл area.tab. З’явиться карта України з межами областей. 
2) Відкрийте файл city.tab. З’являться обласні центри. 
3) Відкрийте файл ukr_2 (район).tab. З’являться межі районів. 
4) Відкрийте файл town.tab. З’являться міста. 
5) Відкрийте файл rway.tab. На карті з’являться найбільші залізничні 

магістралі. 
6) Відкрийте файл way.tab. З’являться автомобільні дороги. 
У сукупності відкриті таблиці утворюють картографічну композицію 

«Робочий Набір». Збережете її як «Робочий набір» під обраним Вами 
індивідуальним іменем (команда «Файл > Зберегти робочий набір»). 

Перевага використання Робочого  Набору в тому, що при його 
використанні  зберігається список відкритих таблиць і вікон, а також дані 
про їхнє розташування на екрані в тій послідовності,  яку вони мали в процесі 
попереднього сеансу роботи. Будь-які, відкриті раніше таблиці (включаючи 
тимчасові) і вікна можуть бути завантажені знову, якщо відкрити робочий 
набір. 

 
УВАГА! Завжди записуйте ім’я вашого Робочого Набору й місце його 

збереження на комп’ютері. Створені вами дані будуть використовуватися 
при виконанні наступних робіт.  

 
7) Закрийте програму MapInfo . 
8) Відкрийте її знову, при цьому виберіть опцію «Відкрити Робочий 

набір». З’явиться створений Вами робочий набір. Одна з переваг 
робочого набору полягає в тому, що однією операцією реалізується 
кілька операцій, які довелося б робити при індивідуальній роботі з 
таблицями. 
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9) Використовуючи кнопку «Лупа, що збільшує, » збільшити масштаб.  
10) Використовуючи команду «Карта > Показати як було» відновити 

первинне зображення. 
11) Використовуючи кнопку «Лупа, що зменшує»,  зменшити 

масштаб. 
12) Використовуючи кнопку «Долонька»  змістити зображення. 
13) Використовуючи команду «Карта > Показати шар повністю», 

відновити зображення. 

14) Використовуючи кнопку «Керування шарами» , відкрити 
діалогове вікно «Керування шарами». 

 
15) Виділити шар area.tab наведенням вказівника на назву шару й 
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наступним натисненням кнопки миші. 
16) Натисканням кнопки «Up» (Нагору) пересуньте цей шар вище за 

інші. 
17) Закрийте вікно «Керування шарами» натисканням кнопки «ОК». 

Карта повинна змінити вигляд. Шар area.tab закриє всі інші. Цей 
приклад показує, що розташування шарів відіграє важливу роль і не 
може бути довільним. Верхні шари закривають нижні.  

18) Використовуючи кнопку «Управління шарами» , відкрити 
діалогове вікно «Управління шарами». Виділите шар area.tab. 
Натисканням кнопки «униз» перемістіть цей шар нижче інших. 
Закрийте вікно «Управління шарами» натисканням кнопки «OK».  

19) Використовуючи кнопку «Лупа, що зменшує»,  і кнопку 
«Долонька» , знайдіть такі міста: Київ, Харків, Львів, Донецьк, 
Севастополь. 

20) Автоматичний пошук потрібного міста (населеного пункту). Перед 
виконанням вправи відмасштабуйте зображення так, щоб на екрані 
містилася вся карта України. 

Вибрати команди «Запит > Знайти». У графі «шукати в таблиці» вибрати 
шар у якому буде проводитися пошук. Оскільки ваше завдання – пошук міста, 
ви вибираєте шар town.tab.  

У графі «Об’єкти з колонки» установити значення  u-name. 
Натисніть на 

кнопку 
«Позначити 
символом» і 
виберіть стиль 
символу. Це 
необхідно для 
того, щоб 
знайдене місто 
було відразу добре 
видно на карті. 
Рекомендуємо 
обрати знак 
«зірочка», 

червоного кольору, розміром не менше 36. Натисніть «ОК». 
З’являється наступне віконце. У графі «u-name» наберіть назву шуканого 

населеного пункту.  
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УВАГА! Назва набирається 
українською мовою!  

Натисніть кнопку «OK». 
На рисунку ліворуч ви бачите, що в 

графі «u-name» набрана назва Харків. 
Нижче представлено кілька міст зі 

схожою назвою. Виберіть у списку Харків і 
натисніть «OK». 

На вашій карті Харків буде відзначений 
великою червоною зірочкою.  

За допомогою автоматичного пошуку 
знайдіть такі міста: Луцьк, Чернігів, Черкаси, 
Кривій Ріг, Лебедин. 

Контрольне завдання. Створіть Робочий Набір, що складається з файлів 
town.tab. rway.tab. way.tab. Автоматично підпишіть назви всіх міст, 
використовуючи діалогове вікно «Управління шарами», поставивши позначку 

 у віконці «підписи» . 
Знайдіть на електронній карті України населений пункт, у якому ви 

проживаєте. За допомогою 
інструментів «Долонька» й 
«Лупа» зорієнтуйте карту 
таким чином, щоб у центрі 
екрана був ваш населений 
пункт. Збережіть Робочий 
Набір під  новим іменем. 

УВАГА! Всі створені, 
або змінені Вами файли 
обов’язково зберігайте під 
новою назвою у створеній 
Вами власній папці. 
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Лабораторна робота № 2. Редагування даних 
 

Мета роботи: навчитись  редагувати дані в ГІС MapInfo  –додавати, 
змінювати та вилучати інформацію електронних таблиць. 

Хід роботи 
1) Відкрийте створений вами на попередньому занятті Робочий Набір. 
2) Збережіть шар ukr_2 (район).tab під іншою назвою. Наприклад - 

ukr_new.tab. Для цього виберіть 
опцію «Файл>Зберегти як» 
(File>Save Copy As…). 

3) З’явиться вікно «Save Copy 
As». Серед запропонованих файлів 
знайдіть необхідний і натисніть 
кнопку «Save As».   

4) У результаті: файл 
ukr_2(район).tab продубльований під іншою назвою. 

 
5) Файл ukr_new.tab  

створений, але ще не відкритий 
у вашому робочому наборі. Для 
того, щоб відкрити його 
скористайтеся опцією 
«Файл>Відкрити…» 
(File>Open…). 

6) Виконайте: «Таблиця > Змінити 
> Перебудувати» (Table > Maintenance > 
Table Structure). З’явиться вікно 
відповідного виду: 

7) Виберіть опцію «Add Field» 
(додати колонку). У графі «Name» 
напишіть ім’я колонки «Площа_району», 
у графі «Type» укажіть опцію «Float» 
(число з «плаваючою» комою). Порожня 
колонка додана до таблиці. Ваша 
команда виконана, але файл при цьому 
автоматично закривається. Відкрийте 
знову файл, що ви редагуєте – 
ukr_new.tab. 
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8) Використовуючи кнопку «Долонька»
, змістіть зображення так, щоб була видна 

область України, яка задає Вам викладач. 
Закрийте всі таблиці крім нової ukr_new.tab 
командою «File>Close table» (Файл > Закрити 
таблицю). 

9) Відкрити табличні дані файлу 
ukr_new.tab командою «Windows >New 
Browser Window»  
Відкриється таблиця, що містить атрибутивні 
дані, пов’язані із відкритим вами 
картографічним шаром даних (ukr_new.tab). 

10) Відкрити одночасно карту районів України і таблицю, що їй відповідає 
командою «Windows >Tile Windows» (Розташувати поруч).  

11) Знайдіть у таблиці задану область. Відзначте один з районів області в 
таблиці – на карті повинен автоматично виділитися  контур даного району. 
Кнопкою «стрілка» виділіть об’єкт на карті. У таблиці повинно з’явитися 
виділення рядка, відповідного до цього об’єкта.  Як бачимо, таблиця й карта 
інтерактивно зв’язані між собою. 

12) Активізуйте вікно з картою та натисніть кнопку «Інформація» . 
З’явиться вказівник у вигляді символу хреста й відкриється допоміжне вікно 
«Інформація». 

13) Виділіть об’єкт на карті. У вікні «Інформація» з’являться табличні дані 
(елементи рядка 2-3-х стовпців) відповідні до виділеного об’єкта. За допомогою 
кнопок прокручування можна виводити вміст різних стовпців для даного 
об’єкта. Установкою вказівника у вікно «інформація» можна активізувати 
чарунку колонки й міняти її вміст. Це один із способів унесення змін у 
таблицю. Впишіть у відповідні чарунки декількох районів дані про їх площі, які 
виберіть з файлу Площа_району.doc. (Цей файл міститься в папці ГІС, 
відкрийте його у окремому вікні.)  

14) Редагувати таблицю можна по-іншому. Перейдіть у вікно з 
табличними даними. Раніше вами була створена нова колонка в цій таблиці. 
Впишіть у цю колонку дані про площу районів заданої області. 

Контрольне завдання. Заповніть нову колонку даними про площу районів 
заданої області, що містяться в папці «ГІС» в файлі площі_районів.doc. 
Збережіть зроблені вами у файлі зміни «File>Save Table» (Зберегти Таблицю).  
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Лабораторна робота № 3. Відкриття та реєстрація растрового зображення 
Мета роботи: навчитися відкривати растрові зображення в ГІС – MapInfo  

та прив’язувати їх до системи географічних та умовних координат. 
Хід роботи 

Растрові зображення необхідно реєструвати (робити позиційну прив’язку 
до системи координат), якщо вони призначені для роботи з векторними даними. 
Файли зареєстрованих растрових зображень містять контрольні точки 
прив’язки, визначені при реєстрації. Тому процедура відкриття растрового 
зображення  різна для реєстрованих і незареєстрованих зображень. 

3.1. Відкриття незареєстрованого растрового зображення 
У MapInfo можна відкрити незареєстроване растрове зображення й 

показати його у вікні Карти, не реєструючи його вручну. Це припустимо, якщо 
інформація про координати контрольних точок не важлива, наприклад, у 
випадку, коли зображення не є картою (наприклад, логотип). 

Для того, щоб відкрити зображення, не реєструючи його вручну: 
1) Виконайте 

команду: «Файл > 
Відкрити Таблицю». 
З’явиться діалог 
«Відкрити таблицю». 

2) Зі списку «Типи 
файлів» виберіть 

«Растр» або «Raster image».  
 

3) Виберіть файл, який Ви прагнете відкрити, і натисніть «OK».  
З’явиться діалог, що 

пропонує Вам вибрати чи 
реєструвати (Register) 
зображення, чи просто 
показати (Display). Натисніть 
кнопку«Display» (показати). 
Зображення з’явиться у вікні 
Карти. 

Буде створений *.tab 
файл, що використовує умовні планові координати. У таких випадках MapInfo  
використовує власні тимчасові контрольні точки для орієнтації й розташування 
зображення на екрані. 

Якщо згодом користувач  захоче використовувати зображення разом з 
векторною Картою, то він має  перереєструвати зображення. Для цього 
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необхідно виконати кроки 1 і 2 з описаної вище процедури. Оскільки файл *.tab 
уже був створений, MapInfo  запропонує побудувати таблицю заново. Виберіть 
кнопку «Реєструвати» для того, щоб перейти до діалогу «Реєстрація 
зображення». Для реєстрації зображення попередньо повинні бути визначені 
точки, координати яких відомі. 

3.2. Реєстрація растрового зображення 
Реєстрація необхідна для прив’язки растрового зображення до заданої 

системи координат. Реєстрація растрового зображення можлива двома 
методами. У першому координати контрольних точок карти вводяться 
користувачем із клавіатури, в – другому – вони визначаються по існуючій 
векторній карті. 

Прив’язка растрового зображення може здійснюватися як до 
загальноприйнятої географічної системи координат (довгота та широта), так і 
до відносної системи координат, обраної користувачем саме для конкретного 
зображення. 

Абсолютні (географічні) координати дозволяють получити повноцінне 
картографічне зображення, що може співставлятися та накладатися на інші 
зображення тієї ж території,  в тому числі космічні знімки.  

Відносні координати, обрані для реєстрації зображення (з урахуванням 
його масштабу), дозволяють, як і абсолютні, проводити вимірювання площ, 
відстаней, але не дають можливості співставлення даного зображення з іншими, 
тобто дуже обмежують можливості його подальшого використання та аналізу.  

Метод реєстрації зображення застосовується, коли необхідно 
векторизувати растрове зображення, для якого відсутній його векторний 
аналог. Іншими словами, така реєстрація необхідна при створенні нової карти.  
Такий підхід вимагає попереднього визначення координат точок карти, які 
будуть використовуватися як контрольні. Тобто у розпорядженні оператора 
повинна бути таблиця з координатами можливих контрольних точок. 
Ефективність цього методу підвищується, якщо контрольні точки маркіровані, 
тобто виділені на растровому зображенні та на його паперовому оригіналі.  

Для визначення відносних координат на паперовому зображенні, 
цифровий аналог якого буде реєструватися в ГІС, проводять дві 
перпендикулярні лінії – осі координат, точка перетинання яких має координати 
(0, 0). На паперовому зображенні визначають характерні точки, які легко 
можуть бути визначені на електронному зображенні з мінімальною похибкою – 
перехрестя доріг та інших ліній. Точки мають бути максимально віддалені одна 
від одної – краще по кутах зображення. Кількість точок – не менше чотирьох.  
Опускаючи перпендикуляри від обраних точок на осі координат та виміряючи 
лінійкою відстань до вісі X та Y, визначають відповідні координати  точок. 
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Якщо відомий масштаб, в якому виконано паперове зображення (план чи 
карта), координати перераховують згідно з масштабом, для отримання даних 
про реальні відстані та площі. 

Для визначення абсолютних (географічних) координат використовують 
або прив’язку точок місцевості  за допомогою приладу GPS (що здійснюється 
оператором безпосередньо при проведенні польових досліджень на місцевості, 
що в подальшому картографується), або координати знімають з існуючих 
паперових чи електронних зображень, якщо вони мають координатну сітку, чи 
дозволяють автоматично визначати координати (наприклад, програма SAS-
planet). 

3.2.1. Реєстрація растрового зображення за абсолютними 
координатами 

Для здійснення реєстрації першим методом необхідно виконати такі 
процедури: 

1) Виконайте команду «File > Open table», і на екран буде виведений 
діалог «Open table».  

2) У меню «Типи файлів» виберіть «Raster image». У списку файлів 
MapInfo  покаже всі імена растрових файлів на поточному каталозі. Виберіть 
растровий файл, який ви прагнете відкрити, і натисніть на кнопку «Відкрити».  

3) З’явиться таке вікно:  
Ви можете відкрити 

файл лише для перегляду, без 
реєстрації (опція «Display») і з 
реєстрацією (опція «Register») 
Виберіть опцію «Register». 

4) MapInfo  відкриє 
діалог «Реєстрація 
зображення». У нижній 
половині цього діалогу у 

віконці буде показаний попередній вигляд растрового зображення. Внизу 
віконця з картою, що відкриється, розташовані кнопки прокрутки, кнопки 
масштабування з позначками «+» та «-» і внизу панелі ряд панелі кнопок, у 
якому розташована кнопка вибору проекції зображення «Projection».  
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5) Виберіть проекцію для растрової карти в діалозі «Projection». Якщо 

растрове зображення отримане скануванням карти, то задайте проекцію, яку 
має використана карта. Якщо проекція растрової карти невідома, то в полі 
«Category» використовуйте стандартну проекцію «Latitude/Longitude» 
(довгота/широта). У поле  «Category  Members» укажіть «Latitude/Longitude 
(WGS84)». Натисніть на кнопку «OK». 

6) Для розміщення контрольних точок помістіть курсор у вікно з 
растровим зображенням у  точку, яку прагнете вибрати як контрольну. 
Натисніть і відпустіть клавішу миші, і на екран буде виведений діалог «Add 
Control Point» («Додати контрольну точку»). 

7) Уведіть у віконце діалогу «Додати контрольну точку» координати 
Карти, які ставляться у відповідність із даною контрольною точкою.  

УВАГА! Координати растра контрольної точки поміщаються 
автоматично. Змінювати їх не потрібно. 
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Значення у віконцях «Растр» виміряються в пікселах. Натисніть на 
кнопку «OK». 

Виберіть не менше трьох 
контрольних точок. Якщо точку у 
віконці на растровому зображенні не 
видно, переміщайте зображення за 
допомогою кнопок прокручування. Для 
прив’язування зображення необхідно 
вибирати точки з найкращим 
розпізнанням на знімку. Примітка: будь-
яка точка, що знаходиться на захід від 

нульового меридіана, має негативну довготу. Будь-яка точка, що знаходиться 
південніше екватора, має негативну широту. Так, 52 градуса на захід від 
Гринвіча відповідають X координаті  -52. 

УВАГА! При введенні координат опорних точок зверніть увагу, що 
географічна широта відповідає координаті Х, довгота – Y. 

Значення координат Карти повинні вводитися в десяткових градусах, а 
не в градусах/хвилинах/секундах.  

8) Повторіть 6 і 7 кроки для визначення другої і третьої контрольних 
точок. Для забезпечення більш точних  результатів можна ввести надлишкові 
вимірювання, тобто ввести п’ять або шість контрольних точок. Кожна 
контрольна точка допомагає MapInfo  зв’язувати земні координати з 
положенням на растровому зображенні.  

Ідеально, якщо контрольні точки задаються  в кожному куті растрового 
зображення  або хоча б недалеко від кожного кута. Такий спосіб завдання 
підвищує точність прив’язки растра до векторного зображення. Число 
необхідних контрольних точок залежить від типу проекції  зображення. 

9) Натисніть на кнопку «OK» після того як усі контрольні точки будуть 
додані. MapInfo  покаже растрове зображення у вікні Карти.  

Після виконання реєстрації зображення MapInfo  створить табличний 
файл (файл із розширенням .tab), де буде збережена інформація про реєстрацію. 
Наступного разу це растрове зображення можна відкрити як звичайну таблицю 
без повторення реєстрації. 

3.2.2. Реєстрація растрового зображення за відносними координатами 
1) Оберіт точки прив’язки на паперовому зображенні та визначте їх 

відносні координати як описано на с.20. 
2) Виконайте пп. 1-4 як при реєстрації за абсолютними координатами. 
3) Відкривши діалог «Реєстрація зображення», та натиснувши кнопку 

вибору проекції зображення «Projection», оберіть тип «Non-Earth», та вид 
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проекції, залежно від масштабу визначених вами координат (мм, см, м або км). 
4) Здійсніть реєстрацію зображення, як описано в пп. 6-9 на с. 22-23, 

вводячи у відповідні чарунки визначені Вами відносні координати. 
3.3. Відкриття зареєстрованого растрового зображення 
Для того, щоб відкрити вже зареєстроване растрове зображення: 
1) Виберіть «Файл > Відкрити таблицю» («File<Open Table»). 
2) Виберіть таблицю зі списку в діалозі, що з’явився (*.tab файл 

містить інформацію про контрольні точки прив’язки, визначені у процесі 
реєстрації). 

3) Залишіть тип таблиці незміненим (MapInfo ). При реєстрації вже 
був створений файл, необхідний для читання таблиці MapInfo  (.tab файл). 

4) Натисніть «OK». MapInfo  відкриє таблицю, що містить растрове 
зображення, і покаже його у вікні Карти. 
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Лабораторна робота № 4. Геокодування баз даних 
 

Мета роботи: навчитися додавати просторово згруповану текстову 
табличну інформацію до баз даних ГІС-MapInfo  шляхом геокодування даних. 

Хід роботи 
1) Використовуючи меню «File > Open...», відкрийте файл Харківська 

обл.txt. 
З’явиться вікно конвертації:  
2) Виберіть опцію «Use First 

Line for Column Titles». Ця опція 
вказує на те, що перший рядок 
файлу Харківська обл.txt буде 
використана як заголовок нової 
таблиці. Натисніть «OK». Текстова 
таблиця перетворена у формат 
Мapinfo. 

3) Відкрийте цю таблицю, 
ознайомтеся з нею: «obl»– область; 
«rajon» – район; «Erod» – площа 
еродованих орних земель, %; 
«Shower_los» – Змив ґрунту при зливах (т/га); «Snow_loss» – Змив ґрунту при 
сніготаненні (т/га); «Kreo»- КРЕН - коефіцієнт реалізації ерозійної небезпеки. 

Тепер ваші дані доступні для роботи в ГІС, але поки ще не мають 
географічної прив’язки.  

Установіть географічну прив’язку файлу Харківська обл.txt за збігом 
назв районів даного файлу з назвами районів файлу ukr_2 (район).tab, 
виконавши наступні дії.  

4) Відкрийте файл ukr_2 (район).tab. 
5) Виберіть команду «Table>Geocode».  Відкриється вікно геокодування 
 
6) У першому рядку «Geocode Table» виберіть таблицю, яка потребує 

географічної прив’язки (файл Харківська обл.txt). 
7) У другому рядку «using Column» виберіть колонку таблиці, яка буде 

служити кодом для прив’язки. У нашому випадку геокодування буде 
проводитися за збігом назв районів – колонка rajon. 

8) У рядку «Search Table» необхідно вказати таблицю, що має 
географічну прив’язку по якій буде проводитися геокодування файлу 
Харківська обл.txt. Указуємо таблицю – ukr_2 (район).tab. 
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9) У рядку «for Object in Column» необхідно вказати колонку таблиці 
ukr_2(район).tab, по якій буде проводитися зіставлення двох таблиць – це 
колонка rajon.  

10) Натисніть «OK». Відкрийте  файл Харківська обл.tab. Тепер ваша 
таблиця має географічну прив’язку: кожний район відображається на карті 
символом зірочки. Розташування зірочок відповідає географічному положенню 
центру району. 
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Лабораторна робота № 5. Обмін інформацією між таблицями 
 
Мета даної роботи: навчитися підключати до однієї з таблиць частину 

інформації, що міститься в іншій. 
Хід роботи 

1) Відкрийте файл ukr_2 (район).tab. 
2) Відкрийте файл Харківська обл.tab. 
3) Підключимо до файлу ukr_2 (район).tab інформацію про змив ґрунту 

при зливах і сніготаненні, яка знаходиться у файлі Харківська обл.tab 
(колонки «Shower_los» – змив ґрунту при зливах (т/га) і «Snow_loss»- змив 
ґрунту при сніготаненні т/га); 

4) Виберіть команду 
«Table>Update Column». З’явиться 
вікно:  

5) У рядку «Table to Update» 
необхідно вказати таблицю, до якої 
інформація буде додаватися (ukr_2 
(район).tab). 

6) У рядку «Column to Update» 
необхідно встановити опцію «Add 
new temporary column» (Додати нову 

колонку), оскільки ми не прагнемо перераховувати якусь із існуючих колонок, а 
прагнемо додати нову. 

7) У рядку «Get Value From Table» слід вибрати назву таблиці-донора 
(Харківська обл.tab). 

8) У рядку «Calculate» слід залишити параметр «Value» (Значення), у 
рядку «of» – указати рядок таблиці Харківська обл.tab звідки буде 
копіюватися інформація («Shower_los» – змив ґрунту при зливах (т/га)).  

9) Натисніть на кнопку «Join», з’явиться вікно:  
10) У перших двох рядках 

установіть значення rajon. Це 
показує, що додавання колонки буде 
проводитися за принципом збігу назв 
районів. Натисніть «OK». У таблицю 
ukr_2 (район).tab додана необхідна 
інформація. 

11) Аналогічно додайте в ukr_2 (район).tab інформацію про втрати 
ґрунту при сніготаненні («Snow_loss»). 
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Лабораторна робота № 6. Просторовий аналіз даних 
 
Мета даної роботи: зробити найпростіший візуальний просторовий 

аналіз наявних даних. Розрахувати сумарні втрати ґрунту від злив і 
сніготанення й побудувати тематичну карту, що відбиває обсяги 
середньорічного змиву ґрунту та розподілу ерозійних втрат на снігові та 
зливові. 

Хід роботи 
1) Відкрийте файл ukr_2 (район).tab. 
2) Спочатку додайте в структуру таблиці нову колонку. Для цього 

вибираємо команду «Table > Maintenance > Table Structure». З’явиться вікно:  
3) Виберіть опцію «Add Field» (додати колонку). У графі «Name» 

напишіть ім’я колонки «Total 
Loss», у графі «Character» 
укажіть опцію Float. Порожня 
колонка додана до таблиці. 

4) Виберіть команду 
«Table>Update Column». 

У рядках «Table to 
Update» і «Get Value From 
Table» укажіть таблицю 
ukr_2 (район).tab. 

У рядку «Column to 
Update» укажіть колонку 
«Total Loss». 

У рядку «Get Value 
From Table» за допомогою опції «Assist» наберіть вираження 
«Snow_loss+Shower_los». 

Натисніть «OK». У колонку «Total Loss» будуть автоматично вписані 
результати розрахунку сумарних втрати ґрунту від дощової та снігової ерозії. 

Виберіть «Map> Create Thematic Map> Bar Chats> Bar Chats Default». У 
діалоговому вікні, що з’явилося, натисніть кнопку  «Next». 

У наступному вікні у графі «Table» виберіть файл ukr_2 (район).tab, а в 
полі «Field» колонки  «Shower_los»,  «Snow_loss», «Total Loss». Натисніть 
кнопку  «Next». 

Не змінюючи нічого в діалоговому вікні, що з’явилося, виберіть кнопку 
«OK». З’явиться картограма змиву ґрунтів по районах Харківської області. 
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Лабораторна робота №7. Виділення заданої області 
 

Мета роботи: навчитися методам виділення необхідної просторової 
інформації із загальної бази даних ГІС 

Хід роботи 
1) Виберіть одну з областей України для подальшої роботи. 
2) Відкрийте файл ukr_2 (район).tab. З’являться границі районів. 
3) Виділіть в автоматичному режимі всі райони, що входять у вашу 

область. Для цього скористайтеся командою «Query> Select…» 
На екрані з’явиться вікно: 

1) У першому рядку меню 
виберіть таблицю з якою будете 
працювати – ukr_2 (район).tab. У 
другому рядку відзначте умови 
вибору необхідних об’єктів. Згідно 
із завданням треба вибрати всі 
об’єкти певної області, наприклад 
Київської. Для цього необхідно 
скласти такий вираз: obl = «Київська». У цьому випадку obl – є колонкою, що 
містить необхідну нам інформацію про приналежність району тієї або іншої 
області, «Київська» – умова нашого вибору. 

2) На екрані з’явиться таблиця зі списком обраних районів. 
Скористайтеся командою «Windows>Tile Windows» для одночасного перегляду 
таблиці й карти. 
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3) Наступним кроком потрібно скопіювати обрані райони в окремий 
файл. Для цього виберіть команду «Edit>Copy». Усі виділені райони будуть 
скопійовані в буфер обміну. 

4) Використовуючи кнопку «Керування шарами»  відкрийте 
діалогове вікно «Керування шарами»:  

5) Зробіть «Робочий шар» (Cosmetic Layer) таким, що редагується. Для 

цього в колонку «Редагувати»  поставте позначку «». 
6) Виберіть команду «Edit>Paste». Обрані райони будуть скопійовані в 

«Робочий шар». 
7) Використовуючи кнопку «Керування шарами», зробіть невидимим 

шар ukr_2 (район).tab. Для цього видаліть позначку «« з колонки «Видимий 

шар» . На екрані буде відображатися тільки «Робочий шар» з обраними 
районами. 

8) Збережіть «Робочий шар» окремим файлом. Для цього виберіть 
команду «Map> Save Cosmetic Objects» і збережіть «Робочий шар» під обраною 
вами новою назвою.  
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Лабораторна робота № 8. Складання робочого набору для окремої області 
 
Мета роботи: навчитися процедурі графічного синтезу необхідної 

інформації. 
Хід роботи 

1) Відкрийте файл area.tab. З’явиться карта України із межами 
областей.  

2) Виділіть задану область. 
3) Використовуючи алгоритм, описаний у попередній роботі, 

скопіюйте задану область у «Робочий набір» і збережіть як окремий файл. 
Відкрийте його. 

4) Закрийте файл area.tab. 
5) Відкрийте файл town.tab. З’являться міста. 
6) Вашим завданням буде виділення (вирізка) міст, що входять у 

задану область.  
7) Зробіть шар область.tab таким, що редагується. 
8) Виділіть область і використовуючи команду «Objects> Convert To 

Regions» переконвертуйте заданий вами об’єкт із класу «полілінія» у клас 
«полігон». 

9) Зробіть шар town.tab. таким, що редагується. Використовуючи 

кнопку , виділіть усі об’єкти даного шару. 
10) Використовуючи команду «Object>Set Target», зробіть даний шар 

цільовим. 
11) Потім виділіть вашу область: її контур буде «формою» для 

виділення (обрізки) міст, що перебувають у її межах. 
12) Використовуйте команду «Object>Erase Outside». У результаті на 

екрані залишаться 
лише міста, що входять 
у дану область. 

 
УВАГА! У 

результаті попередніх 
операцій файл town.tab 
змінений і містить не 
всі міста України, а 
лише ті, які належать 
до вашої області. НЕ 
ЗБЕРІГАЙТЕ його! 
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Для того, щоб коректно зберегти потрібну вам інформацію й не 

спотворити вихідний файл (town.tab) зробіть таке: виберіть команду «File>Save 
Copy As…» (зберегти копію). 

13) На екрані з’явиться меню.  
Виберіть серед запропонованих вам шарів шар town.tab і натисніть 

кнопку «Save As». Задайте нове, унікальне ім’я для збереження інформації. 
Наприклад, town_kiev.tab. У новому файлі таблиця буде містити лише міста 
даної області. 

УВАГА! Не зберігайте всі інші таблиці!  
14) Відкрийте файл rway.tab. На карті з’являться найбільші залізничні 

магістралі. 
Повторивши всі попередні операції, створіть файл, що містить лише ті 

відрізки залізниць, які проходять по території заданої області. 
15) Відкрийте файл way.tab. З’являться автомобільні дороги. 
Повторивши всі попередні операції, створіть файл, що містить лише ті 

відрізки автомобільних доріг, які проходять по території заданої області. 
У підсумку ви повинні мати такі файли: 1) файл із контурами вашої 

області; 2) файл із районами, що входять у вашу область; 3) міста вашої 
області; 4) залізничні магістралі міста вашої області; 5) автодороги міста вашої 
області. 

16) Збережіть всі ці таблиці як Робочий Набір. 
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Лабораторна робота №9. Оформлення карти області 
 
Мета роботи: навчитися оформленню створеної в ГІС – карти й 

підготовці її до друку. 
Хід роботи 

1. Відкрийте Робочий Набір, який ви створили на минулому занятті. Він 
повинен містити такі файли: 1) растрове зображення ґрунтової карти; 2) 
усі векторні шари, які ви створили. 

2. Ваше завдання – оформити всі обрані шари як карту. 
Перший крок, який необхідно зробити – оптимально розмістити заданий 

набір на екрані комп’ютера. Уявіть, що монітор – це аркуш паперу на якому 
буде надрукована ваша карта. За допомогою інструментів «Лупа» і «Долонька» 
так установіть розміри й розташування вашої карти на екрані монітора, щоб 
вона перебувала в центрі екрана й займала б на ньому максимальну кількість 
місця. 

3. Створіть легенду до вашої карти. Для цього виберіть опцію «Map\Create 
Legend…». У вікні, що з’явилося, натисніть кнопку «Finish». З’явиться 
легенда до карти. 

4. Створіть новий Шар (New Layout Window). Для цього виконайте команду 
«Windows >New Layout Window». Цей шар дозволить створити макет 
вашої карти для подальшого друку. 

5. З’явиться наступне вікно. 
Натисніть кнопку ОК.  

6. З’явиться вікно наступного вигляду. 
Це макет вашої карти, що містить 
обрані вами шари й створену легенду. 

  
7. Усі підписи в легенді можна редагувати. Для цього натисніть кнопку 

«Windows» і виберіть вікно, що відображає легенду. Подвійним «кліком» 
на назві умовного знака ви можете відкрити вікно, що дозволяє 
редагувати й форматувати текст. Перепишіть усі умовні позначення 
російською або українською мовою. 
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8. Зверніть увагу – усі зміни, зроблені у вікні Легенда, будуть автоматично 
відбуватися й у вікні Шар. 

9. Натисніть кнопку «Windows» і виберіть вікно, що відображає шар-Макет. 
Красиво розмістіть на ньому карту й легенду. 

10. Використовуючи кнопки  «вибір шрифту» і  «підпис»,   обирайте 
стиль та розмір шрифту  та зробіть  надписи, вказані в пп. 11 та 12. 

11. Зробіть заголовок карти. Наприклад: «Карта Харківської області». 
12. Зробіть штамп до карти: «Виконав: студент ** групи, ** курсу  ПІБ. 

Прийняв: ПІБ». 
13. Створений шар-макет карти повинен бути збережений. Для цього 

збережіть всі відкриті вікна як робочий набір з унікальним іменем.  
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Лабораторна робота №10. Векторизація растрового зображення 
 
Мета роботи: навчитися на основі растрових карт та інших зображень 

створювати векторні геоінформаційні бази даних та цифрові карти.  
Векторизація растрового зображення здійснюється за допомогою 

комп’ютерної миші та кнопок інструментальних панелей «Пенал» («Drowing») 
та «Операції». Векторне зображення так би мовити «рисується» по растровій 
основі на новому картографічному векторному шарі, аналогічно до того, як 
рисують зображення маркером на поверхні прозорої плівки, що покладена на 
паперовий рисунок. Такою «плівкою» є косметичний шар «Cosmetic layer», а 
«паперовою основою» відкрите та зареєстроване растрове зображення. 

Хід роботи 
1) Відкрити растрове зображення (космічний знімок), що було 

зареєстроване Вами при виконанні лабораторної роботи №3 (файл *.tab) 

2) Використовуючи кнопку «Керування шарами»  відкрийте 
діалогове вікно «Керування шарами»:  

3) Зробіть «Робочий шар» 
(Cosmetic Layer) таким, що редагується. 

Для цього в колонку «Редагувати»  
поставте позначку «». 

Векторна карта, створена на 
основі знімка, повинна мати декілька 
окремих тематичних шарів інформації: 

a. Дороги. 
b. Будівлі. 
c. Зелені насадження. 
d. Водні об’єкти. 
e. Сільськогосподарські угіддя. 

Кожен шар створюється окремо. Наприклад, спочатку створюється шар 
«дороги».  

4) Для цього, натиснувши на панелі «Drowing» кнопку «стиль лінії» 

 оберіть товщину та колір лінії, якою будуть позначатися дороги певного 
типу на векторній карті. 

5) Натиснувши на панелі «Drowing» кнопку «полілінія»  та 
розмістивши курсор на екрані, нарисуйте дороги, повторюючи лінії растрового 
зображення. Кожен «клік» миші створює вузол, від якого напрям прямої можна 
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змінювати, подвійний «клік» дозволяє завершити рисунок. 
6) Після того, як всі об’єкти одного шару (у даному випадку – дороги) 

нарисовані на робочому (косметичному) шарі, шар інформації необхідно 
зберегти у вигляді табличного файлу.  Для цього виберіть команду «Map> Save 
Cosmetic Objects» і збережіть «Робочий шар» під обраною вами новою назвою. 
Наприклад - Дороги.tab. 

7) Знову зробивши робочий шар доступним для редагування (п. 3), 
створіть наступний тематичний шар інформації. При цьому враховуйте таке: 
площинні об’єкти, для яких важлива їх площа, а не лише протяжність – 
лісонасадження, будівлі, ставки, поля тощо рисують як «полігон», обираючи 

відповідно, кнопки  для вибору стиля (кольору, штриховки) та  для 
малювання  об’єкта.  

8) Точкові об’єкти, площина чи протяжність яких неважлива, наносять 

використовуючи кнопки  та  для вибору стиля та нанесення позначки, 
відповідно.  

 

9) Кнопки  («вибір шрифту») та  («підпіс») використовують 
для створення підписів.  

10) Повторюючи кроки, описані в пп. 3-6 послідовно нарисуйте та 
збережіть окремими тематичними шарами всі наявні на растровому зображенні 
об’єкти.  

11) Закрийте растрове зображення. Збережіть Робочий набір. 
12) Використовуючи навички, отримані в роботі №9, оформіть 

отриману векторну карту у вигляді шару-макета. Збережіть його.  
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Питання модульних контрольних робіт 
 

1. Що розуміють під терміном „дані”? 
2. В чому полягає розбіжність між поняттями „дані” і „інформація”? 
3. Що розуміють під терміном „інтерпретація”? 
4. Як можна перетворити дані в інформацію? 
5. Що розуміють під терміном „інформація”? 
6. В яких формах можна виразити адекватність інформації? 
7. Які основні вимоги висуваються до інформації? 
8. Що розуміють під терміном „моделі даних”? 
9. Які принципи організації просторової інформації Вам відомі? 
10. Що розуміють під інформаційними системами? 
11. Які головні компоненти включають інформаційні системи? 
12. Що представляє собою ГІС? 
13.  В чому полягає відмінність ГІС від інших ІС? 
14. Які функції притаманні ГІС? 
15. Які технології притаманні ГІС? 
16. З яких функціональних підсистем складається ГІС? 
17. Назвіть технології, які використовують ГІС? 
18. Назвіть приклади застосування ГІС. 
19. Які розділи повинно включати документування в ГІС? 
20. Що розуміють під просторовими даними? 
21. Що розуміють під терміном „карта”? 
22. Що розуміють під терміном „цифрова карта”? 
23. Що розуміють під терміном „електронна карта”? 
24. Що розуміють під терміном „геозображення”? 
25. Що розуміють під терміном „геокод”? 
26. Що розуміють під терміном „генералізація”? 
27. Які види генералізації Вам відомі? 
28. Назвіть складові просторової інформації. 
29. Що розуміють під терміном „просторові дані”? 
30. Що розуміють під терміном „атрибутивні дані”? 
31. Що розуміють під терміном „просторові відношення”? 
32. Що розуміють під терміном „часові дані”? 
33. Чим характеризується геопростір? 
34. Назвіть компоненти геоінформаційного простору. 
35. Дайте характеристику безперервним явищам. 
36. Охарактеризуйте картографічні джерела даних. 
37. Назвіть типи картографічної інформації. 
38. Які два типи картографічної інформації Вам відомі? 
39. Охарактеризуйте ДЗЗ, фотограмметричні дані в якості джерела 

даних для ГІС. 
40. Охарактеризуйте геодезичні та топографічні дані в якості джерела 

даних для ГІС. 
41. Охарактеризуйте статистичні дані в якості джерела даних для ГІС. 
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42. Як можна класифікувати растрові моделі? 
43. Дайте характеристику форматів, використовуваних растровими 

моделями. 
44. Дайте характеристику регулярним мережам, як способу 

формалізації просторових даних. 
45. Дайте характеристику полігонам Тиссена, як способу формалізації 

просторових даних. 
46.  Дайте характеристику регулярним трикутним сіткам неправильної 

форми, як способу формалізації просторових даних. 
47.  Дайте характеристику пірамідальним моделям, як способу 

формалізації просторових даних. 
48.  Дайте характеристику квадротомічним деревам, як способу 

формалізації просторових даних. 
49.  Назвіть приклади застосування растрових моделей. 
50. Що з себе представляють растрові моделі? 
51. Назвіть основні характеристики растрових моделей. Що є базовим 

елементом зображення у векторній моделі? 
52. Що є базовим елементом зображення у векторній моделі? 
53. Що розуміють під терміном „просторова розрізнюваність”? 
54. Що є найменшим елементом візуалізації поверхні в растровій 

моделі даних? 
55. Що є найважливішою властивістю растра? 
56. Чому в растрових моделях відпадає  необхідність в засобах 

зберігання й обробки атрибутивних даних? 
57. Як можна класифікувати растрові моделі? 
58. Дайте характеристику форматів, використовуваних растровими 

моделями. 
59. Що лежить в основі векторного методу формалізації просторових 

даних? 
60. Що є базовим елементом зображення у векторній моделі? 
61. Що означає термін „цифрування”? 
62. Чим визначається точність векторної моделі? 
63. Що означає термін „ідентифікатор”? 
64. Що означає термін „топологія в ГІС”? 
65. Що означає термін „топологічний простір”? 
66. Чим визначається топологія для площинних об’єктів? 
67. Які відношення застосовуються для аналізу топологічних зв’язків 

між об’єктами векторно-топологічних моделей? 
68. Дайте загальну характеристику способів формалізації просторових 

даних. 
69.  Охарактеризуйте векторну модель просторових даних. 
70. Які процедури в ГІС відносять до просторового аналізу? 
71. В чому полягає сутність буферного аналізу? 
72. Які типи буферизації Вам відомі? В чому їх сутність? 
73. Назвіть типи буферів, використовуваних в ГІС. 
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